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Limitation of liability 

  

PANLAB does not accept responsibility, under any 

circumstances, for any harm or damage caused directly or 

indirectly by the incorrect interpretation of what is expressed 

in the pages of this manual. 

Some symbols may have more than one interpretation by 

professionals unaccustomed to their usage. 

PANLAB reserves the right to modify, in part or in total, the 

contents of this document without notice. 
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1. INTRODUCTION 

This manual contains material for the experimenter who wishes to 

use PPCWIN to simultaneously monitor up to 8 Conditioned Place 

Preference (CPP) or Black and White (B&W) boxes. 

It is divided into two parts: installation procedure and experiment 

execution.  

We suggest the user to conscientiously read the overall manual 

before beginning an experiment to avoid any hardware damage 

and software malfunctioning due to any possible misuse of the 

system. 

Thoughout the manual, the following signal will indicate the points 

that require a special attention from the user.  
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2. INSTALLATION OVERVIEW 

The installation procedure is completely described for reading 

during the installation procedure. Therefore, they are stand-alone 

and can be executed separately as per your needs: acquisition 

(USB Key must be connected), analysis, reporting (printer must 

be installed), etc. 

First of all, please check that your user has administrative rights 

on the PC or laptop in which the software or device is to be 

installed. Please contact your IT staff in order to clarify this issue 

before the installation procedure is done. 

Additionally, you will find details about how to configure some 

requirements which should be fulfilled to be able to install this 

system. 

 

2.1. Requirements 

PPCWIN needs the following equipment: 

▪ A fully compatible computer with at least: 

▪ 2 GHz Pentium® (Celeron processor excluded). 

▪ 2 Gb of RAM. 

▪ 150 MB of free hard disk space. 

▪ Graphics: 1024x768 pixels and 32-bit true color. 

▪ 1 free USB port for the protection key. 

▪ Connection interface: 

▪ 1 free RS-232 serial port for the boxes connection. 

A USB-Serial adapter included in the software pack can be used 

when a RS-232 serial port is not available. 

▪ Operating system supported: 

▪ Microsoft® Windows® 11 64bits 

▪ Microsoft® Windows® 10 32bits and 64bits 

▪ External software needed: 

▪ Microsoft Excel ®. 

▪ Microsoft Word ® (only for reports in Word format). 

If external software is not available, some analysis reports 

cannot be generated. Please contact your IT staff in order to 

install the external software before analyzing sessions. 

▪ Printer (recommended): 

At least one “virtual printer” must be correctly installed. Please 

refer to section 2.5 for more details. 
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2.2. Installing Software 

PPCWIN software is delivered within a single USB flash drive. The 

USB flash drive contains the software installation tool, this User’s 

Manual in PDF format and other components required to work in 

specific conditions.  

Due to security reasons of the Windows® operating system, a 

user with administrative rights is required to install the software 

and other components. Please contact your IT staff before 

installing the software. 

Once you get the administrative rights to install the software, 

please follow these steps:  

▪ Plug the USB flash drive in a free USB port of your computer 

and wait until Windows® installs it as a new removable drive. 

▪ Access the new removable drive detected and execute the 

PANLAB.EXE file. A window will be shown, as below: 

 

▪ Press the [Install PPCWIN v2.0.05] button to start the software 

installation.  

▪ An installation wizard will appear. Press the [Next] button to 

start the software’s installation.  
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▪ Read the License Agreement and check the “I accept the 

terms of the license agreement” option to continue the 

installation of PPCWIN. Then press the [Next] button to start 

the installation.  

▪  

▪ In the next windows introduce the name of the user and the 

company in the correct field. After this, press [Next] button to 

continue. 

 

▪ During the installation process, the software is installed in a 

new folder called [PPCWIN v2.0\] created under the Programs 

Files folder. If desired, the installation program allows you to 

choose another folder to locate the software. The location of 

the software is independent of the data folder, which is defined 

by the user using the corresponding options of the program. 
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▪ Press the buttons [Next] and [Install] following the Install 

Shield Wizard until reaching the [Finish] button.  

▪ A new shortcut will appear on your desktop. Use it for 

executing the program later.  

 

 

2.3. Installing software protection key  

PPCWIN software is delivered with a USB protection key that 

avoids fraudulent use of the application in a computer which does 

not have it installed.  

Before installing the drivers, all applications must be closed and 

all USB SuperPro keys must be removed. 

In order to do a correct USB key protection installation, please 

follow the steps below:  

▪ Press the [Install Software Key Drivers] button to start the 

driver’s installation.  

 

▪ Automatically a USB key wizard installation will be shown. 

When the Welcome screen appears, click [Next] to continue.  
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▪ Choose [I accept the terms in the license agreement] and click 

[Next] button to continue. 

 

▪ On the incoming window select the [Complete] option of setup 

type and click [Next] and [Install] buttons to continue.  

 

▪ After pressing the [FINISH] button, you must reboot the 

system. Thus, your computer will recognize the USB security 

key. 

▪ Did you reboot the computer? If you answer yes, please 

connect the USB key. In the lower right corner of the screen 

will appear the next message.  

 

▪ The wizard for installing the drivers will run when your 

computer detected correctly the USB key. This process will 

need some minutes depending on your PC. 
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▪ Choose [Automatic Installation] and press the [NEXT] button.  

 

▪ Wait while the wizard looks for the drivers until it asks you to 

press the [FINISH] button. 

▪ Finally, a new message will appear in the lower right corner of 

your screen. The USB key was installed correctly...  

 

Important remark: This step has to be repeated for each USB port 

of your computer.  

  

http://www.panlab.com/


 

Page 8 

PPCWIN 2.0.05 Manual • Publication MAN-SOFT PPCWIN Rev 01 • www.panlab.com  ©2024 Panlab 

2.4. CONRS232USB-HS converter (high speed mode) 

PPCWIN requires the use of the high-speed converter from RS232 

port to USB port. A USB – Serial adapter will allow you to set 2 

serial ports in your PC or laptop. 

 

 

 

WARNING: do not use direct connection between the device and 

the computer RS232 serial port (if any). 

 

 

 

We recommend the use of a specific model of converter. We cannot 

guarantee the correct functioning of the system with any other 

USB-serial converter. The converter includes an extension cable 

just in case. 

To Install the converter: 

• Connect the converter to the computer. 

• Windows 8, 10 and 11 will automatically install the drivers. 

• If working with a Windows 7 or previous, please refer to 

the notice provided in the box of the converter. 
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• Once connected and installed, two serial ports will appear 

in the [Device Manager] window on the Windows Operative 

System. Usually, the numbers assigned by Windows are 

sequential. 
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2.5. CONRS232USB (blue) converter (Legacy mode) 

The blue RS232/converter was included in older PPCWIN software 

packages. 

PPCWIN is still compatible with the use of the system in a Legacy 

mode (not high-speed). In case you need to re-install this device, 

please follow the below procedure: 

▪ You need to have administrator privileges to install any new 

drivers under Windows 10/8/7/Vista/2003/XP/2000. To install 

the driver or update the configuration please log onto Windows 

as "Administrator" or ask your system administrator to install 

the USB to serial driver. Please contact your IT staff in order 

to clarify this issue before continuing installing the device. 

▪ The drivers should be installed prior to hardware installation. 

Do not connect the USB to serial I/O Adapters to the USB port 

of your computer, before you finish driver installation. 

▪ Insert the PPCWIN software USB flash key into a free USB port 

of your computer and access its content. 

▪ If your PC is running Windows XP, a manual installation 

is required: go to folder Files\USBCom and execute file 

USBCom-CDM_20824.exe 

▪ Otherwise, for the rest of Windows versions, execute 

the installation assistant (Panlab.exe). The following 

installation window will be shown. Press the [Install 

Drivers USB-RS232] option to start the software 

installation process. 

 

▪ The USB COM install program will auto-detect the OS type and 

install the driver automatically. In some operating systems, it 

might appear a dialog box asking to press [ENTER] at the end 

of the installation. 
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▪ After the message “FTDI CDM Driver installation process 

completed” appears, press “Enter” to complete the driver 

installation. 

▪ Plug in the USB PRO Series Adapter to the USB port of your 

computer. Windows will finish installing the driver files. 

 

▪ In the lower right corner of the screen the next message will 

be automatically shown: 

 

▪ At the same time, two devices will appear in the [Device 

Manager] window. The ports provided by the new [USB FAST 

SERIAL ADAPTER] will be shown under [Other devices] with a 

warning sign attached. 

 

▪ Please, wait while the wizard locates the drivers installed 

previously. This process may require some minutes depending 

on your PC. 
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▪ The process of the correct activation of the device (that is, 

when the PC or laptop recognizes the new serial port), is done 

one by one. 

 

▪ The next picture shows how the number of the port is finally 

assigned by the system. 

 

▪ When the wizard finishes will ask you to press the [FINISH] 

button. 

Important remark: 

Until now, only one serial port has been correctly installed. The 

process must be repeated for the second port. Please, wait while 

your PC or laptop finds another COM port. Once again, the next 

message will appear in the lower corner of the screen: 
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▪ The adapter will be correctly installed when all previous steps 

have been repeated. Finally, the message will appear in the 

lower right corner of. 

 

▪ At the same time, the two serial ports will appear in the 

[Device Manager] window. Usually, the numbers assigned by 

the system are sequential. 

 

A yellow label with the text [Port 1] is attached to the adapter 

device to identify the first port recognized for the computer 

system. That means that if [Device Manager] shows two ports 

(COM3/COM4 or higher numbers), then that label [Port 1] 

corresponds to COM3 or the lower number of the new created 

COMs. 
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2.6. Installing a Printer by default 

If there is not a printer installed in your PC, one virtual printer 

must be installed by default. If your PC is running Windows 10, 

there are two virtual printers installed by default (Microsoft XPS 

Document Writer and Microsoft Print to PDF) and no additional 

action is required; but for earlier Windows versions, the next steps 

must be followed to fulfil the system requirements. 

▪ Go to [Printers and Faxes] option of your system. The access 

is possible by clicking on [START – Settings] 

 

▪ In the [Printers and Faxes] window press on the [Add printer] 

button. 
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▪ The Welcome to the add printer wizard appears, click [Next] 

to continue. 

 

▪ As this procedure is for installing a virtual printer, the options 

must be selected as is shown in the next window. Press [Next] 

button to continue. 

 

▪ The wizard will search the drivers for the virtual printer. This 

process will need some minutes depending on your PC. 
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▪ The wizard notifies that there is not a real printer present. 

Press [Next] button to continue. 

 

▪ Obviating the previous message, the options for the next 

window must be selected as shown in the next picture before 

pressing the [Next] button. 

 

▪ The virtual printer will be a [Generic / Text Only] thus these 

options must be selected in the next window before pressing 

the [Next] button. 
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▪ This virtual printer can be called [PANLAB] so that it can be 

easily identified when a real printer is connected to the system. 

The option [No] must be selected before pressing the [Next] 

button. 

 

▪ Of course, it is not necessary to share the PANLAB printer so 

select the [Do not share this printer] option and press the 

[Next] button to continue.  

 

▪ It is not necessary to print a test page either so select the [No] 

option for answering to the wizard and press the [Next] button 

to continue. 

 

http://www.panlab.com/


 

Page 18 

PPCWIN 2.0.05 Manual • Publication MAN-SOFT PPCWIN Rev 01 • www.panlab.com  ©2024 Panlab 

▪ The wizard will copy the drivers for the virtual printer. This 

process will need some minutes depending on your PC. 

 

▪ When the virtual printer is successfully installed the wizard 

shows you a window as the next picture. Press [Finish] button 

 

▪ A new icon will appear in [Printers and Faxes] window called 

[PANLAB]. Close the window and launch the software. 
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3. BOX DETECTION 

This section explains in detail how to detect the boxes connected 

to the computer and that would be used with the PPCWIN 

software. 

Configuration window can be shown through Configuration > 

Communications… menu option. 

The corresponding configuration window is:  

 

 We can see different parts in this window: 

▪ Serial port: It indicates the port number where is connected 

the hardware. 

▪ Found boxes: It indicates the list of boxes found in the serial 

port selected after pressing [Find boxes] button. 
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If the computer is connected to a Place Preference box, the PPC 

BOX name will be displayed in the Devices column. 

 

If the computer is connected to a Black and White box, the B&W 

BOX name will be displayed in the Devices column. 

 

In order to get a correct detection of the boxes, each interface box 

should be configured with a consecutive Id. Number (back panel 

of the control unit). From 1 to 8.  

▪ Details button: It shows information of both the connection 

process with the box and the boxes detection process. 
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▪ To configure the communications:  

 

▪ Select the communications port. 

▪ Press [Find boxes] button. 

Depends on the result of connection: 

▪ If connection fails a message like this will be shown: 

 

 

Should this occur, please check the following points: 

▪ Boxes connections are established as referred to in the 

corresponding manual. 

▪ Control unit is connected to the PC with the right cable and in 

the selected COM port. 

▪ This COM port is not used by another running application. 

▪ If a USB adapter is used, the corresponding drivers are 

correctly installed. 

▪ If connection doesn’t fail, you’ll see the list of boxes in the list 

“Found Boxes”. 

▪ If the shown list is the correct list, you must press OK button 

and the application will create the corresponding boxes to 

start, else if the list is incorrect, please repeat the steps from 

number 2 after changing the serial port selected. 
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3.1. Compartment name selection in place preference 

boxes 

When place preference boxes are used an additional option is 

proposed after pressing the OK button in the previous step – Box 

detection (see “Connection with the device” panel described in the 

previous chapter) 

As two kind of place preference boxes can be used (Black & White 

model or Dots/Stripes model), this additional option allows 

choosing the name of the compartment that would be display in 

the data runtime panel and data reports. 

 

 

 

 

Whether you open and save an already existing file with a different 

name configuration, a message would pop up asking the user to 

choose between keeping the previous name or changing to the 

new designation. 

 

Whether the new designation is chosen, the changes would be 

seen the next time the file is opened in the runtime panel and 

Zone report.  

An important note is that the name of the compartments displayed 

in the Transition table report for experiments that have been 

registered with a version previous to V2.0.04 cannot be updated 

with the new names. 
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3.2. Detection of the subject’s position in the boxes 

During the execution of the experimentation trials, PPCWIN 

software continuously registers the position (box compartment) in 

which the subject is located. 

3.2.1. Detection of the subject’s position in The Black and White 

boxes 

In the Black & White box, two compartments are available with 1 

sensor below each compartment.  

The animal position is then determined depending on the 

activation of each sensor by the weight of the animal.  

 

3.2.2. Detection of the subject’s position in place preference boxes 

In the place preference box, three compartments are available: 

the White/Dots compartment, the Black/Stripes compartment and 

the corridor. Only 2 compartments have 1 sensor: the 

Black/Stripes compartment and the corridor. 

This means that if the subject is not detected in the Black/Stripes 

compartment and the corridor, it would be considered as detected 

in the White compartment by the software. 

A special case is the use of the “Improved detection” option (by 

default option).  

In that case, the final position of the subject inside the box is by 

default determined by means of a filtering process that avoids the 

generation of inconsistent position sequences (e.g., the subject 

goes from “White” compartment directly to the “Black” 

compartment without entering the “Grey” compartment). 

This filter can be counterproductive when the subject moves too 

fast for the box electronics to correctly detect the changes. 

The activation or deactivation of this filter can be done through 

the Configuration > Improved detection menu option. 

If this option is checked, the filtering process will be enabled so 

that the position of the subject will be determined not only by the 

information provided by the boxes interface but also considering 

the previous position. So, it may happen that the box interface 

shows the subject detected in the White/Dots compartment when 

the software still considers it in the Black compartment. In that 

case, this is the software that would manage to show the correct 

way to detect the subject using the improved detection option. 

If this option is unchecked, the filtering process will be disabled so 

that the position of the subject will always match with the one 

provided by the boxes interface, even when the positions 

sequence was inconsistent. 
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4. PREPARING A SESSION 

This section explains in detail how to prepare a session in PPCWIN. 

A PPCWIN experiment consists of a set of sessions executed on 

available boxes (at the same time or not) and with a unique 

subject on each box. 

The first time PPCWIN starts probably you will receive a message 

like this: 

 

This is an information message that advises you about the 

requirement to configure the RS232 port to establish the 

communication between the computer and the boxes. Please refer 

to chapter X to carry out this task. 

Once you have done it and every time that you start PPCWIN, 

Boxes Bar is shown at the bottom of the window. 

 

Boxes Bar includes a button for each available box. Each button 

has the number of the box and its state (running, stopped or 

testing) showing as a colored led. 

Pressing consecutively a box button will show and hide the 

corresponding Box Window: 

 

The name of the compartment would depend on the model of box 

used (CPP or B&W boxes) and on the compartment name selection 

(only for CPP boxes) 

For the B&W boxes a central empty column is shown that would 

not be filled. This is due to the shared internal structure of these 

tables with the different models of boxes with 2 or 3 

compartments. 
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Box windows can also be shown or hidden by marking options on 

View > Boxes > Box menu. 

 

Each box window has four different parts: 

Box identification: shown in the title bar of the window. 

 

Session information: in which Experimenter must enter subject 

name, subject group (optional) and session duration. 

 

This last value can be indicated on two ways:  

▪ Fixed duration: you should enter a duration in a format 

hh:mm:ss. Session will then automatically end when execution 

time reaches specified duration. 

▪ Free-running: checking Free-running box will allow PPCWIN to 

continuously execute session until User presses Stop button. 

▪ Session data: in which PPCWIN shows zone entrance and 

permanence statistics as well as transitions list during session 

execution. 

 

The values of the central column are disabled with B&W boxes 

(Black and White simulators – only with two compartments). 

Transitions list shows and stores all zone changes (time and zone) 

that have taken place since session start.  

Control panel: which allows Experimenter starting and stopping 

the session as well as testing box communications. 

  

http://www.panlab.com/


 

Page 26 

PPCWIN 2.0.05 Manual • Publication MAN-SOFT PPCWIN Rev 01 • www.panlab.com  ©2024 Panlab 

Control panel also gives information about the current session 

time and subject position. 

 

Pressing [Play] button will start the session in the selected box. 

Pressing [Stop] button will immediately stop the session and store 

current session statistics into experiment data table. This button 

is enabled only when a session has been started. 

[Test] button is used to switch box to Test mode. In this mode, 

only subject position is updated in the Box Window, allowing User 

to verify communications with the chamber. Test mode will end 

when User presses [Test] button again. 

Subject position is shown as a colored box indicating the zone 

in which the subject currently is. Colors used are black, white, 

grey for the B&W boxes and black & white CPP, dots/grey/stripes 

patterns for the dots/stripes CPP boxes and yellow (indicating that 

no subjects are in the box). 

Current session time (chrono) is located on the right side of the 

control panel. Its format is hh:mm:ss. 

In summary, in order to prepare a session, you should: 

Configure the communications (as explained in chapter X) 

Show desired boxes by pressing corresponding buttons on Boxes 

Bar. 

Test communications with the selected boxes. To do this, enter a 

subject into the box or manually press chamber floor and check 

that subject position is correctly shown. 

Enter the name of the subject and, optionally, its classification 

group. 

 

Fix session duration or choose Free-running mode. 
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5. SESSIONS EXECUTION: DATA ACQUISITION 

Only when preparation process has finished, session data 

acquisition can start by pressing [Start] button. 

A functional PPCWIN protection key must be connected in order to 

start data acquisition. 

During the execution of a session, PPCWIN will continuously 

monitor subject position into the chamber and calculate, visualize 

and store the following session data: 

▪ Zone entrances (ENT): total (units) and global percent (0% - 

100%) by zone. 

▪ Zone permanence time (PER): total (time) and global percent 

(0% - 100%) by zone. 

▪ Transitions list: detailed time and zone list. 

▪ Current subject position: shown in the subject position box.  

▪ Current session status: as a background color in the control 

panel: 

▪ Gray: Session is currently stopped. 

▪ Green: Session is currently running. 

▪ Red: Communications have been lost. 

▪ A red colored control panel indicates severe problems with 

chamber communications. In this case, PPCWIN will consider 

that the subject is not changing zone so statistics may be 

affected. 

▪ That is why we suggest you to manually stop session and test 

communications when this occurs. 

▪ Current session time (chrono): in format hh:mm:ss. 

If a fixed duration has been defined, session will automatically end 

when time arises duration. However, both fixed-duration and free-

running sessions can be manually stopped by pressing [Stop] 

button. 
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6. EXPERIMENT DATA TABLES 

Experiment data tables are a detailed online experiment report 

which stores the information generated during the execution of 

several sessions. 

Experiment data table can be shown and hidden through View 

> Experiment data menu option. 

Two kinds of tables are provided: Experiment Table and Transitions 

table. 

Experiment Table: 

 

 

When a sessions is finished (automatically or manually), its 

detailed information (identifier, starting date and time, entries, 

permanence and transitions) is entered in a new row of the table. 

Transitions Table: 

Pressing  button at the end of a row will show a detailed list of 

transitions of that session. 

 

Both reports will show the name of the compartment accordingly 

to the selection made after the box detection process (only for CPP 

boxes). 

The only exception is the name of the compartment in the 

Transition report than cannot be updated with new names when a 

new name selection is requested on an already registered session. 

http://www.panlab.com/
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6.1. Saving experiment data 

Experiment data table content can be stored into a report file 

both in text format and as a Microsoft Excel® document. 

Selecting File > Save or pressing Save experiment button 

located at the top of the Experiment data table will allow User 

to select destination folder, name and type of the report file. 

 

If Text file report type is selected, PPCWIN will generate a pair 

of files with the name of the experiment followed by “_Zones” and 

“_Transitions”. Those files store sessions statistics and transitions 

lists of each session respectively. 

If Excel file report type is selected, a Microsoft Excel® workbook 

is generated including a general sheet named “Zones” and as 

many “Transitions” sheets as sessions are the experiment have. 

 

Once an experiment is saved, its name is shown in the 

Experiment data window title bar. 

File > Save as… menu option and Save as experiment button 

(in the Experiment data window) will allow you to save current 

experiment with a different name or, even, as a different report 

type. 

As an experiment file can be retrieved in the future, you may not 

modify its content. Whether you want to include additional 

information such as Excel® calculations or new rows or columns, 

we strongly recommend you save the original content into a 

different Excel® document and make changes to this new file. 

6.2. Retrieving experiment data 

Experiment files can be loaded in order to review its content and 

/ or to include additional sessions in the same file. 

To do this, you can use File > Open… menu option or Open 

button located at the top of the Experiment data window. Then, 

you should locate and select the experiment file (any of the text 

files or the Excel file). 

Once the experiment file is loaded, its content is shown into the 

Experiment data table and you are allowed to start and add new 

sessions information. 

  

!!
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7. STARTING A NEW EXPERIMENT 

Selecting [File – New] menu option will start a new blank 

experiment.  

As this option cleans all previous experiment information, PPCWIN 

asks User for saving changes. 

Even so, please make sure that the information of the current 

experiment is not required before using this option. 

 

8. EXITING PPCWIN APPLICATION 

[File - Exit] menu option will exit PPCWIN application. Before that, 

PPCWIN will ask whether you want to save previous changes into 

an experiment file. 

When exiting PPCWIN application, current desktop arrangement 

(position and size of the windows) is stored so it can be restored 

when starting application again. 
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9. CONTACT INFORMATION 

 

We are available to help you with your questions and concerns. Should you hit a 
roadblock or need some additional training, please feel free to visit the HBIO 
Behavioral Support Center at https://support.behavior.hbiosci.com to find 
articles and helpful information in our knowledge base or submit a ticket. We are 
happy to help! 

PANLAB 

Carrer de l’Energía 112 

08940 – Cornellà de Llobregat 

Barcelona - SPAIN 

  

Technical Support 

Email: support@panlab.com 

 

 

 

 

http://www.panlab.com/
https://support.behavior.hbiosci.com/
mailto:support@panlab.com
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